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This manual is a work in progress. It is continuously being improved and revised to reflect the latest version of EnvisioKnit Design
Studio. If you feel that anything is missing or unclear, please let us know and we'll be happy to fix it.

In addition to this manual, we also have a 15 minute demonstration video, which is probably a better place to start if you are new to
EnvisioKnit.
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Intro Screen

Create a New Chart

Getting started

The Intro Screen
When you start EnvisioKnit Design Studio, the first
thing you will see is the intro screen. From here, you
can choose to create a new design or open one that
you've already started.

If it's been a while since you downloaded EnvisioKnit,
there may be an update available. EnvisioKnit checks
for updates every time it starts, so if there is one, a
window will appear and ask if you'd like to update. The
updater takes care of downloading and installing the
new version automatically, but afterwards you will
need to close EnvisioKnit and restart it to run the new version.

Creating a New Design

If you select to create a new design you will be
prompted to create your initial chart.

You can enter the name of the chart, its size, gauge,
and you can specify the yarn and stitch motif that will
be used to fill the chart.

The size of the chart can be set either by entering the
number of rows and columns, or by entering the height
and width. If you enter rows and columns, the height
and width fields will be calculated for you. Likewise, if
you enter the height and width, the rows and columns
will be calculated. The calculation is based on your
gauge setting.

The available stitch motifs are stockinette (all knit),
reverse stockinette (all purl), garter, moss, seed, rib
and blank (all no-stitch).

You can add additional yarns to your design by clicking the Add New Yarn button. Additional yarns can also be added at any time
later. To change the existing yarn, just double click on it, and the Yarn Studio window will appear. To remove a yarn from the design,
select the yarn and click the 'X' icon that appears in the lower right of the yarn button.

Opening an Existing Design

If you choose to open an existing design, you will get
the typical Open File window, where you can select
the EnvisioKnit design file you want to load.
EnvisioKnit uses the file extension .ekd for design
files.
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Open a Design File
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Chart Navigation Button

Yarn Navigation Button

Navigation Bar

The Main Window

The Main Window
Once you have a design open, you will see the main
EnvisioKnit Design Studio window. At the top, you will
notice a toolbar with three large buttons: Yarn, Charts
and Pattern.

This is the Navigation bar. These buttons let you navigate through the elements of your design.

Clicking the Yarn navigation button will allow you to add a new yarn or select
one to edit.
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Settings Menu

Edit Menu

Menu Bar

File Menu

Pattern Navigation Button

Likewise, clicking the Charts button will let you add a new chart or select a chart to edit.

The pattern button will open the pattern editor. You always have one pattern
associated with your design.

Above the Navigation toolbar you will find the Menu bar.

The Menu bar contains the typical menus you are probably familiar with from other
applications.

From the File menu, you can create a new design, open an existing design,
close, save or print the current one, or exit the program.

The Edit menu provides the usual editing commands: Undo, Redo, Cut, Copy
and Paste.

The Settings menu contains options to set the cable symbol style used for all
your cable stitches and to set the fonts used in your current design (see Font
Settings). It also has options for setting and clearing your default preferences
(See Default Design Settings).

The Tools menu has an Import tool that will allow you to bring charts, yarn and
stitches from other design files into your current design. (see Importing).
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Tools Menu

Help Menu

The Help menu features a link to this Manual, which will open in your browser
when you click on it. There is also a Check for Updates option that will check
the website and let you know if there is an update available. The About
EnvisioKnit page will simply tell you the version of the program.

Below the Navigation toolbar you will have your chart editor, which we will
continue with in the next section.
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Mode Buttons

The Chart Editor

Chart Editor

Overview
The chart editor will open whenever you select a chart
or create a new one. It also opens by default when you
open a design.

(Note: if your screen doesn't look similar to the one on
the right, you may have clicked the pattern navigation
button earlier. To go back to the chart editor, click the
Charts navigation button and select the chart to edit.)

The chart editor is split into two panes. The large pane
on the left is the edit pane, and it's for displaying and
editing the chart. The narrow pane on the right is for
palettes and settings.

If you look at the top of the palette pane, you will notice five small buttons.

These buttons allow you to switch editing modes. There are five chart editing modes: the Yarn and Stitch,
Chart, Border, Instructions, and Preview editing modes. If you click any of these buttons, you will notice
that the toolbar buttons and the palettes will change according to the current mode.
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Selecting Stitches

Drawing Freehand

Yarn and Stitch Toolbar

Drawing with Yarns and Stitches
The Yarn and Stitch editing mode allows you to draw on your chart using a particular yarn and stitch. Select the yarn and stitch from the
palettes on the right, and the tool you want to draw with. The Yarn and Stitch Mode toolbar will look like this:

Now let's go through what each of these
tools does.

Select

Allows you to select regions of your chart. Usually
select is used with other tools, for instance, to select
a region and then copy and paste it to another
location.

To select an area of the chart, left-click on one corner,
drag to the opposite corner of the area and release the
mouse button.

To add additional regions to your selection, hold the
Control key and select another area. New areas can
overlap or be separate from your initial selection. This
makes it possible to select areas which are not
rectangular or connected.

Once you have an area selected, right-click on it to
see a menu with the functions that you can apply to it.
In addition to the cut, copy and paste functions, there are options to:

Replace yarns and stitches within the selection.
Draw a border around the selection.
Create a new chart from the selection.
Repeat the selection in the written instructions.
Omit the selection from the written instructions.

Draw Freehand

The basic draw tool. Draws the selected yarn and
stitch wherever you click on the chart. Click and drag
to create a continuous line of stitches.
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Drawing Lines

Drawing a Rectangle

Draw Line

Draws a straight line. Click where you want the line to
begin, drag to where you want it to end, and release
the mouse button.

Draw Rectangle

Draws an unfilled rectangle. Click where you want one
corner of the rectangle to be, and drag to where you
want the opposite corner and release the mouse
button.

Draw Filled Rectangle

Draws a filled rectangle. Again, click where you want
one corner to be, and drag to the opposite corner.
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Drawing a Filled Rectangle
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Filling Inside the Rectangle

Erasing part of the chart

Fill

Fills all cells in a connected region with the selected
yarn and stitch. Click inside the area you want to fill.

Erase

Erases stitches. This is identical to drawing with the
no-stitch.
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Rotating Stitches 90 Degrees CCW

Rotating Stitches 180 Degrees

Rotate 90 Degrees Counter Clockwise

Copies the selected region of stitches and rotates it
by 90 degrees counter clockwise. The rotated copy
will follow your cursor around the chart until you click
the mouse button to place it.

Rotate 180 Degrees

Rotates a selected region of stitches 180 degrees.
Works the same way as the rotate 90 degrees tool,
but rotates 180 degrees.
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Rotating Stitches 90 Degrees CW

Flipping Stitches Horizontally

Rotate 90 Degrees Clockwise

Rotates a selected region of stitches 90 degrees
clockwise.

Horizontal Flip

Copies the selected region of stitches and flips it
horizontally. The flipped copy follows your cursor
around the chart until you click the mouse button to
place it. Mirrors directional stitches such as
decreases, increases and cables horizontally as well
(for instance, k2tog flips to ssk).
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Flipping Stitches Vertically

Cropping the Chart

Vertical Flip

Flips the selected region of stitches vertically. Works
like the horizontal flip tool, but flips vertically.

Crop

Reduces the size of the chart to just the selected
region. To use the crop tool, first select the region you
want to crop to and then press the crop button. Your
chart will be reduced to just the region you selected.
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Zooming In

Zooming Out

Zoom

Zooms in or out, making the chart appear larger or
smaller. Clicking the left mouse button zooms in...

And clicking the right mouse button zooms out.
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Zooming to Fit

Zoom to Fit

Zooms the chart to best fit the edit window.
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Zoom to Height

Zooms the chart to fit it vertically within the edit window.
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Cutting Stitches Out

Zoom to Width

Zooms the chart to fit it horizontally within the edit window.

Cut

Removes a region of stitches from the chart, copies
them to the clipboard, and replaces them with no-
stitches. Select the stitches you want to cut, and
press the Cut button. Alternatively, you can press Ctrl-
X on the keyboard.

Copy

Copies the selected region of stitches to the clipboard. Select the stitches you want to copy and press the Copy button. Alternatively,
you can press Ctrl-C on the keyboard.
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Pasting Stitches

Paste

Pastes the stitches on the clipboard to the chart. If
you have already cut or copied stitches, press the the
paste button, or alternatively Ctrl-V on the keyboard.
The pasted stitches will follow your cursor around the
chart until you click to place them.

Undo

Reverts your last chart edit.

Redo

Redoes the last chart edit you have undone.
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Chart Drawing Toolbar

Drawing with another Chart as a Motif

Chart Drawing Mode

Drawing Chart Motifs
The Chart drawing mode allows you to draw on your
chart using your other charts as motifs.

The Draw Chart tool is the only tool in the Chart Drawing Toolbar that we didn't see already
in the Yarn and Stitch Toolbar.

Draw Chart

Select a chart to draw with from the chart palette on
the right. Then select the Draw Chart tool button. The
selected chart will follow your cursor around the chart
until you click the mouse button to place it.
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Editing Border Properties

Border Mode

Border Mode
The border editing mode lets you draw borders on your
chart. The available borders are shown in the palette
on the right.

Click Add New Border to create additional borders,
or double-click on a border in the palette to edit it.

The Name you give your border will be shown in the
legend. You can customize the border Color, which is
used for both lines and text. The Line Width, or
thickness, can also be adjusted, relative to the size of
the chart grid.

Denoting the Border in the Written Instructions

The Written Instructions option allows you to denote
the border in the written stitch instructions. The
Written Instructions setting options are:

None - This is the default setting, so no written
instructions are initially associated with the
border.
Place Marker: pm - Inserts the text “pm” into
your written stitch instructions, at the location of
vertical border lines.
Custom - Inserts any text that you specify into
the written instructions, at the vertical border
lines.
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Border Toolbar

Setting Custom Border Instructions

Border Tools
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Drawing a Rectangular Border

Drawing a Border Line

Once you have selected a border, click one of the border drawing tools to draw it on your chart.

Draw Border Line

Draws the selected border on your chart. Left-
click where you want the border line to start, and
continue left-clicking everywhere you want an end-
point. Right-click or press Escape to finish the
border line.

Draw Rectangular Border

Draws a rectangular border on your chart. Left-
click where you want one corner of the rectangle,
and click again where you want the opposite
corner. Right-click or press Escape to cancel.
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Border Text Settings

Draw Border Text

Draws text associated with your selected border. Left-click on the
chart and you will get a pop up window to set the text content and
size. When finished, left-click on the chart to place the text. To
cancel the text placement, right-click or press Escape.

Border Select

You can select and edit your existing border lines
and text with the border select tool.

To edit border text, use the select tool to click on
the text. The text will appear highlighted to show
that it is selected. To move the text, click on it
and then drag to the desired location. To change
the text, double click on it and the border text
editing window will appear where you can change
the content and size of the text.

To edit a border line, left-click anywhere on the
line. The line will be highlighted and the endpoints
will be shown as diamonds.

Click an endpoint to drag it to a different
location...

Or move the whole border line as one by clicking
anywhere else on the border and drag it to the
new location.
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Draw Border Around Selection

Borders can be drawn without using the border tools. Stitch Drawing Mode, you can select an area of the chart, right-click on it and
choose Draw Border Around Selection from the menu. A window will appear where you can choose the border to use. Click OK
and a border line that outlines the selection will be added to your chart. The Border Around Selection tool works for non-
rectangular and non-connected selections as well. This is a quick and simple alternative to drawing border outlines manually.
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Instruction Mode (Flat knitting)

Changing Instructions generated in the Round

Instruction Mode
The Instruction Mode displays the written
instructions for your chart and provides several
options to determine how they should be
generated. The options are listed on the right,
above the instructions. The instructions are
generated automatically and are continuously
updated as you design.

Starting on Right or Wrong side

The Row 1 is right-side option specifies whether
the first row of the chart is a right-side row. If the
chart is worked flat, then the row following the
right-side row will be a wrong-side row. If the chart
is worked in the round then all the rows will be
either right-side or wrong-side, as determined by
the setting for the first row.

Working In the Round

The In the Round option determines whether the
instructions are generated for working the chart
flat or circular. If set, instructions are generated in
the round (circular). Otherwise, they are
generated for flat knitting.
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Generating Colorwork Instructions

Instructions Repeated 3 Times

Colorwork

By default, written instructions are generated only
for the stitch pattern and color changes are
omitted since they are shown in the chart. The
Include Colors option can be set to include
colors changes in the written instructions. The
Use Color Aliases option can be used to
represent the yarn colors with letters (i.e. A, B,
C...). If this option is used, the letters
corresponding to each yarn color will appear in
the yarn legend. Unsetting Use Color Aliases will
generate the colorwork instructions using the full
name of each yarn. For complex colorwork
charts, you may find that using aliases for the
colors helps simplify and shorten the instructions.

Chart Repeats

The instructions can be generated to repeat the
chart a specified number of times. By default, the
instructions are generated for each row in the
chart to be worked once. Setting the Repeat
Chart number will generate instructions for
working the chart the number of times that you
set. For example, if you have a row of 20 knit
stitches and you set Repeat Chart to 3 times,
the corresponding instructions will read K60. This
option is handy if you have a chart that is
repeated across several times and only want to
chart the first repetition.
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Showing the Number of Worked Stitches

Repeated Chart Sections

Including Stitch Counts

The number of worked stitches can be
automatically included at the end of each row
instruction. This option can be enabled by setting
the Include Stitch Counts. Including the stitch
counts in the written instructions can help the
knitter check that each row has been worked
correctly. The instruction count is shown in
parentheses at the end of each row. For example,
[K2, p2] 5 times (20 sts).

Repeated Sections

You may want to generate the written instructions
so that a section of a chart is repeated, but the
rest of the chart is not. You can do this with
repeated sections.

To mark a repeated section, select the area and
right-click on it. Select Repeat Selection from
the menu that pops up and the Repeat Settings
window will appear.

Specify the number of times that the selection
should be worked and click OK. The written
instructions will be automatically regenerated to
reflect your settings. Also, because you are
changing how the chart is worked, the Chart
Checker will be updated as well.

You can mark non-rectangular and non-connected
selections as repeated sections. Overlapping
areas will be merged together. The Undo and
Redo commands work for adding repeats, so you can use them to revert unwanted changes.

Repeat Settings

Each repeated section has settings that you can
adjust to configure how the associated written
instructions are generated. The Repeat Settings
specify the following properties:

The number of times that a repeat is worked.
If the repeat should be outlined with a border
line.
If the literal sequence of repeat stitches
should be preserved, as marked by the
selection, in the generated stitch
instructions. This can optionally be done only
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Repeat Settings

Omitted Chart Section

Overlay Settings

on patterned rows (i.e. not all knit or all purl).
Additionally, the marked sequence text can
be set to appear in a bold typeface in the
written pattern.

Omitted Sections

You can mark areas of your chart to be omitted
from the automatically generated written
instructions. The instruction generator will simply
skip over them. This can be used for many
purposes, but generally it is to show things on the
chart that are not meant to be worked literally.

Omissions can be added and modified on the
Omissions tab. As with repeated sections, to
mark an omitted section, select the area (with the
select tool) and right-click on it. Select Omit
Selection in the menu that pops up. The written
instructions will be automatically regenerated to
reflect your settings and the Chart Checker will re-
validate the chart.

You can have multiple omitted sections. Select
additional areas and click the Omit Selection
button. Overlapping areas will be merged together.
The Undo and Redo commands can be used to revert unwanted changes. Repeated and omitted sections can overlap, the
omissions will take precedence.

To remove an omission, right-click on the area in the chart and select Remove Omission from the menu that appears.

Repeat Overlays and Appearance

A tinted overlay is shown to visually indicate the location of repeats and omissions in
the Chart Editor. This is for your reference while you design, so that you can clearly
see where the repeat is. The overlay will not appear in the final exported chart. You
can configure the appearance of the overlay on the Repeats & Omissions tab (on
the right, above the instructions). Under Show in chart, uncheck Repeats to not
show the repeat overlay in the chart editor. Alternatively, you can change the color to
one that works better for you. Likewise, uncheck Omissions to disable the
omissions overlay.

If you want a visual indicator of a repeat shown on the exported chart, visible to the
knitter, you can automatically add a border line to your repeat by enabling it in the
repeat settings. The border line will be automatically drawn to outline your repeat and
will sync with your repeat shape if you change it later. Alternatively, you can manually draw a border line around your repeat using
the border tools.
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Text Options

Instruction Text Options

The Text tab contains a few more options for the instruction text. The Pattern Text
Settings and Chart Numbering buttons are fairly self-explanatory. The Right-side
rows option allows you to specify which rows should be read as right-side. In the
vast majority of cases, this should be set to the default Right-to-left rows are right-
side. This is the convention for hand knitting charts. However, if you are adapting
your pattern for loom or machine knitting, the All rows are right-side setting will
generate right-side stitch instructions on rows that are worked both right-to-left and
left-to-right. The Left-to-right rows are right-side setting parses the chart left-to-right
on right-side rows and right-to left on wrong-side rows, for left-handed knitting.
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Chart Preview - Scrolling Down

Chart Preview

Preview Mode
The Chart Preview Mode presents the chart as it
will appear when you export it. There are several
options for customizing the look of the chart.
Please note that, with the exception of the font
settings (which apply to the entire pattern), these
settings only affect your current chart.

The main window on the left side of the screen
shows a preview of your chart, and the title,
legend and instructions associated, formatted for
the printed page. EnvisioKnit automatically
formats your chart to fit on the first page, and the
written instructions follow, spanning subsequent
pages, if necessary. When you export your chart
to a paged format (such as PDF, Word, or Open
Office), the page layout should match very
closely, if not exactly, what you see here in the
preview.
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Chart Preview Options

Chart Preview Options

Chart Preview Options

The panel on the right side of the screen contains several options that you can apply
to customize the appearance of your chart. The Title setting for the chart is at the top
and underneath it are 4 tabs containing additional settings: Grid, Legend,
Instructions and Notes. The chart preview will update automatically as you modify
the settings, so you can instantly see the result of your choices.

Title Options

In the title settings, you can set the title of your chart. Just type it in under Title. If
you don't want the title to appear on your chart, disable the Show Title checkbox.
On the right side of the Title settings is a font button, which will open the font settings
for the Chart Titles in your pattern.

Grid Options

There are several options on the Grid tab. The first few items pertain to the grid itself.
You can change the color of the grid by clicking the colored button next to Grid
Color:. Clicking the font settings button will open the font settings for the Chart
Numbers.

Index Lines

Clicking the Index Lines... button will open the
Index Line Settings window. This tool allows
you to configure index lines for your chart grid.
Index lines are heavy grid lines spaced at intervals
to help knitters track their position in the chart.
Index lines are only shown in the chart preview
and the exported chart output, and will not be
visible while you are editing the chart.

You can configure 2 sets of index lines: a minor
set and a major set. This way you can indicate a
small interval and a larger interval, say 5 and 10.
To enable a set of lines, check one or both of the
Horizontal or Vertical checkboxes under
Orientation. You can configure the color, interval
and line width for each set. Please not that the
major set of lines is displayed over the minor set,
so the major set will look best with a line width as
thick or thicker than the minor set.
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Numbering Options

Wrong-side Row Striping

Row Striping Enabled

Row Striping

You can check the Wrong-side row striping option to enable a shaded overlay on your
wrong-side rows. Once checked, you can configure the color and opacity of the overlay. The
row striping is a knitting chart convention that can help make it more apparent to the knitter
that these rows are to be worked from the wrong-
side.

The rest of the settings in the Grid group are related to the numbering of the chart. From the drop-down next to Justify Numbers,
you can select whether to justify the number text to the right, to the left, or towards the chart (numbers on the right of the chart will
be left-justified, and numbers on the left of the chart will be right-justified).

Numbering Options

The numbering options in the chart preview control the appearance of the row and column numbers around the chart grid. To change
the chart numbering scheme (i.e. the starting row and column, etc.) select Set Chart Numbering in the Grid Settings.

Number Justification

Chart numbers can be justified towards the chart, always to the left, or always to
the right.

Number Size

The size of the numbers can be set to large, regular, small or extra small. The
number size is relative to the row height.

Row Numbering

Under the Row Numbers tab, you can choose to place your chart's row numbers at
the beginning of the row, on both sides of the row, always on the right, or on the left of
the row. When numbers are placed at the beginning of the row, the position is
determined by whether the row is a right-side or a wrong-side row. Right-side rows
begin on the right side of the chart, so the row number is placed on the right. Wrong-
side rows begin on the left side of the chart, so the row number is place on the left.

From the drop down next to Show Numbers on you can select Every Row, Alternate Rows, or No Rows. Selecting every row
will show row numbers on every row in the chart. Selecting Alternate Rows will show numbers on alternate rows, and if you
choose this setting, an additional option will appear where you can set how many rows you want to alternate by.

You can set the chart row that you want to start numbering on by adjusting the number next to "Start numbering on row".

Enabling the Skip Every Other Row checkbox will number the chart skipping every other row number (i.e. 1, 3, 5, ...). In this case,
the chart instructions will be generated as though those intermediate rows are not charted, and will include a note that they are to
be worked in the established pattern. This option is particularly useful for lace or aran designs where the stitch patterning is on
alternate rows and the rows between are knit plain.
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Column Numbering Options

Legend Options

Instruction Options

Chart Notes

Column Numbering

Switching to the Column Numbers tab, you will find checkboxes for enabling column
numbers on the top and bottom of the chart.

The Text Orientation option allows you to specify whether the column numbers
should be oriented vertically or horizontally. If the column numbers are oriented
horizontally, EnvisioKnit may scale them down, if necessary, to fit the width of a chart
cell (so that they do not overlap each other).

Legend Options

The legend options includes a set of checkboxes with which you can disable or
enable parts of the legend. You can choose to include or exclude the list of stitches,
yarns and/or borders used in the chart. You can also choose whether those lists
should have headers (i.e. Stitches, Yarns, and Borders), and whether the legend
should be outlined.

Clicking the Font button on the right will open the font settings for the chart legends in
your pattern. You can set separate font styles for the legend contents and the legend
headers.

The Legend Order can be set to order items by their:

order in the palette
appearance in the chart (left-to-right only - this is a legacy option, use worked
order instead)
name, alphabetically
order in which they are worked in the chart

The Legend can include items used in just the current Chart or all items used in the entire Pattern.

The Text Settings button will open the Text Settings for your pattern. Here you can customize the fixed text used for the legend
headers and the stitch legend items.

Instruction Options

The instruction options configure the appearance of the written stitch instructions in
your chart. If you do not want to show the written stitch pattern instructions with your
chart, you can disable the Show Instructions option. Checking the In the Round
option will interpret your chart for circular knitting when generating the instructions for
it.

The Bold Row Labels setting determines whether the row labels (i.e. "Row 1:")
should use a bold font. Using a bold font can help to visually separate the row labels
from the instruction text.

Chart Notes

Designers can include chart notes to appear in the pattern along with an individual
chart. Notes should be text that is supplementary to the charts written instructions and
too specific to the chart to belong in the Pattern summary. The placement of the chart
notes is configurable with the Place Notes setting. The placement options are: before
the chart title, after the chart title, before the written instructions or after the written
instructions.
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Chart Preview Toolbar

Chart Export

You can directly print or export the chart in the Chart Preview by clicking the print
or export buttons in the toolbar (above the main window). Printing or exporting
from the chart preview outputs the current chart only. To print or export the full
pattern, you will need to go to the Pattern Editor.

The available export formats are ZIP, SVG, BMP, PNG, JPG, Microsoft Word (DOCX), Open Office (ODT), PDF and TXT.

Please see the Printing and Exporting documentation for more information about the available options.
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Right-Clicking a cell on the Chart Shows the Menu

Select a Replacement Yarn

Other Chart Editor Features

Replacing Stitches and Yarns

Once you've drawn a design on your chart, you
may want to exchange one stitch or yarn for
another. You can do this instantly with the
Replace feature. Right-click on your chart, on a
cell containing the stitch or yarn that you want to
swap. A menu will appear where you can select
Replace in Chart. Then select one of the
following sub-items: Replace Yarn, Replace
Stitch and Replace Yarn and Stitch

You will be replacing all instances in the chart of
the yarn, stitch, or yarn and stitch (together) of
the cell you have right-clicked on. A window will
appear allowing you to select the replacement
yarn and/or stitch. Make your selection and your
chart will be instantly updated with the change. If
you make a mistake or change your mind you
can revert this command with the Undo button.

Replace Yarn

Right-clicking a chart cell and doing the Replace Yarn command
will replace the yarn of the cell you have clicked, throughout the
chart, with another yarn of your choice. The yarn will be replaced in
all cells that use it, regardless of their stitch. The replacement is
done within the scope of the current chart, so other charts in your
design will not be affected.

Replace Stitch

Similar to Replace Yarn, the Replace Stitch command will swap
the stitch of the cell you have right-clicked, throughout the chart,
with an alternate. The stitch will be replaced in all instances in the
chart, regardless of the yarn it is being used with.

Replace Yarn and Stitch

The Replace Yarn and Stitch command will swap the contents of
all cells that use both the yarn and stitch of the cell you have right-
clicked. For example, consider a chart that uses
white and black yarns, and knit and purl stitches
in both colors. If you do Replace Yarn and
Stitch on a black knit cell, only other cells that
are both black and knit will be replaced.
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The Result after Replacing Blue Yarn with Mauve

Replacing in Selection: Replace Yarn and Stitch for White Purl

The Result after Replacing White Purl with Baby Blue K-tbl in Selection

Replace in Selection

You may want to make a replacement, but only
within a certain part of your chart. You can do this
by first selecting the part of the chart that you
want to replace (with the Select tool). Then, in the
selected area, right-click on a cell containing the
yarn and/or stitch you want to replace. A menu
will appear containing a Replace in Selection
option, with the same sub-options as Replace in
Chart. Replace in Selection works identically,
but only applies the replacement within the
selected area.

Create New Chart from Selection

You can create a new chart from a portion of an existing chart. Select the part of the chart that you want, and right-click on it.
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Right-Clicking on the Chart Shows the Menu

Select Number of Rows to Delete

Select Create New Chart From Selection from the menu that appears. A window will appear where you can set the name of the new
chart, as well as which row and column the chart starts on.

By default, the First Row and Column will reflect the location of your selection in the original chart. If your selection included setup
rows, those will be included by default in the new chart as well. If the first row of your chart is a right-side row, the checkbox
indicating this will be set. All of these settings can be adjusted. The Open in Chart Editor checkbox can be set if you would like to
immediately open this new chart for editing when you click OK.

Inserting and Deleting Rows and Columns

It's possible to remove or insert rows and columns
anywhere on your chart. To do this, just right-click
on the chart where you want to make the change.
A menu will appear so that you can select what
you want to do.

In the example shown on the right, we are
choosing to delete rows.

Select the number of rows or columns to insert or
delete. When inserting, the yarn and stitch motif
of the inserted stitches can be selected.

In our example, we are deleting 7 rows. The rows
that will be deleted are shown highlighted in red.

Click OK and the insertion or deletion is
executed.
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The Rows are Removed from the Chart

Chart Rulers Tracking Rows and Columns

Chart Rulers Tracking Units

Rulers

The chart rulers are always visible whenever the chart is in an editable
mode (every mode except Preview). By default, the rulers track your
cursor position on the chart by row and column.

Clicking the small button in the upper left corner switches the rulers to
track the cursor by units instead (inches or centimeters, depending on
your settings). This helps give you a sense of where you are on the chart
in terms of dimensions. Click the ruler button again to switch back to
rows and columns.
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Cursor Position

Grid Settings Menu

Chart Gauge Settings

Cursor Coordinates

You can always tell which row and column your cursor is on by looking
at the cursor coordinates below chart, on the left.

Grid Settings

Clicking the grid settings button, in the lower left below the chart, opens
a menu with several options related to the chart grid. These settings
include the gauge, numbering, grid color and background color (the
no-stitch color), as well as the options to show the grid and show
borders.

Chart Gauge

Choosing the Set Gauge... item will allow you to adjust the gauge of the current
chart. You can set the number of Rows and Stitches over a Span of inches or
centimeters.

Chart Numbering

Selecting Set Numbering... from the Grid Settings will open
the chart numbering options. Here, you can set the First
Row and First Column numbers for the chart. These can be
any number 1 or greater.

Enabling the Skip every other row option will indicate that
your chart only shows odd or even rows (depending on your
First Row setting). For example, if the first row is 1, then the
next row will be 3, then 5 and so on. This setting is useful if
you are designing a chart that has patterning only on right
side rows. Uncharted wrong-side rows are assumed to be
worked in the established pattern.
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Chart Numbering Options

Labeling Setup Rows

Setup Rows

It is possible to have unnumbered setup rows before the
numbered chart rows begin. You can add them by
specifying the number you want in the Setup Rows
setting. After the setup rows, the chart will begin
numbering with the number you have specified for the
first row. If your chart has setup rows, the first row of
the chart is considered to be the first row after your
setup rows.

Setup rows are unnumbered by default. You can apply
custom labels to setup rows by clicking the Setup
Row Labels... button and entering the label(s) that you
want. Setup rows can be blank, uniformly labeled, or
individually labeled. For example, if you have 2 setup
rows, you can specify "Setup" for the label and it will
apply to both setup rows. For individually labeled setup
rows, specify the labels for each row, separated by
commas (e.g. "Setup Row 1,Setup Row 2"). Each
setup row will be labeled correspondingly.

Pass Settings for Brioche and Other Multiple Pass Charts

Some knitting techniques (such as Brioche and other slipped
stitch patterns) require 2 or more passes to be worked for
each row. This can affect how the chart is numbered and
worked. The Chart Numbering settings include options for
such charts. In addition to specifying the number of Passes
per row, you can specify Pass Labels (in addition to the row
numbers) and which of those passes your chart begins with.

Pass labels can be set to alphabetic, none or custom. The
Alphabetical setting will append a letter to each row number
indicating the pass (i.e. for 2 pass rows: 1a, 1b, 2a, 2b, etc.).
Setting pass labels to None will number the rows
numerically, without pass labels (i.e. 1, 2, 3, 4, etc.). With
Custom pass labels, you can enter a comma-separated
sequence of pass labels to use. For 2 pass rows, you could
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Rows with Multiple Passes

specify custom pass labels " LC, DC" and the result would
be rows labeled 1 LC, 1 DC, 2 LC, 2 DC, etc.

If you have more than one pass per row, but your first row
(not counting setup rows) does not start on the first pass,
you can set the First row is pass setting to the starting
pass. For example, if you have 2 passes per row, a and b,
and you want your chart to start with 1b instead of 1a, then
first row is pass should be set to 2.

If you are working with separate strands of yarn for each pass
(such as for 2 color Brioche) you may want each pass to
start on the same side of the chart per row. With flat knitting,
this means that if the first pass is a right-side pass,
subsequent passes will also be right-side. The passes for the
following row will then be wrong-side. Check Start passes on
same side per row to enable this. If this setting is not
enabled, each pass will start at the end of the previous pass.
The generated stitch instructions and position of the row
numbers at the starting side of the row will reflect this setting.
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The Grayscale button

Viewing a Chart with Grayscale Enabled

Viewing the Chart in Grayscale

For colorwork designs it can be helpful to view the pattern in grayscale
to see how the color values are balanced. EnvisioKnit has a grayscale
viewing option that you can enable to view your chart in grayscale.

The grayscale button is located at the bottom right of the chart editing
panel. Click it to view the chart in grayscale, and click again to view the
chart normally. Please note that grayscale is only a viewing tool, your
chart output will still be in full color even if grayscale is enabled. Also,
the chart preview will be in color even with grayscale enabled.
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Disable Stitch Drawing

Disable Yarn Drawing

Chart Mask Settings

Chart Mask Button
(outlined in red)

Chart Mask Shown and Enabled on Every Other Row and Background

Yarn and Stitch Masking

It is often useful to draw only yarns or only stitches. To do this,
EnvisioKnit allows you to disable either yarn drawing or stitch
drawing. The buttons for disabling stitch drawing and yarn drawing
are located in the bottom right of the chart editing panel.

Disabling stitch drawing is helpful when you are drawing color
patterns and don't want to draw over the established edge of the
chart.

Similarly, adding texture or shaping to a color-patterned area can
be easier if you disable yarn drawing.

Chart Masking

When enabled, the chart mask will preserve masked areas from
being drawn or pasted over. For example, if you would like to draw
over your chart without affecting wrong-side or right-side rows, or
without drawing over an established no-stitch edge, you can do so
with the Chart Mask. Which areas should be masked can be
specified by clicking the Mask button and adjusting the Chart
Mask Settings.

The Mask button is located at the bottom right of the chart editing
panel. If the mask is enabled, the button will appear highlighted.

The Mask Settings include: mask every-other row (with the sub-
option to start on the first row), mask the background (invisible no-
stithc), mask the visible no-stitch, and an option to show the mask in the Chart Editor as an overlay
covering masked regions.
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No errors found

Chart contains errors

Chart Errors Indicated on Chart

The Chart Checker

The Chart Checker is a tool for finding errors in your chart that would make it unknittable. In
general, the number of stitches worked on a row should be equal to the number of stitches made on
the previous row. If that is not the case, a chart error is flagged. The chart checker errors are only
informational, but they can be helpful when proof reading your chart.

The Chart Checker status icon is shown in the lower right corner of the Chart Editor. When no chart
errors are found, the indicator shows a green check icon. If there are errors, a red flag is shown. The
chart checker status is refreshed automatically
whenever you change the chart.

Clicking the Chart Checker icon will open the
Chart Checker window. If there are errors in the
chart, it will present a list of them. Each error
specifies the row it occurs on and the reason
why it was flagged. Selecting an error in the list
will highlight its row in the chart editor window.

In the example shown here, there are two rows
with errors found. As indicated in the Chart
Checker window, Row 11 is lacking an
increase and is highlighted in red on the chart.
Inspecting the row, it appears that a yarn-over is
missing from the pattern. Row 15 is also listed
as lacking a decrease, which could be fixed with
a double-decrease to replace the k2tog in the middle of the row.

49



Pattern Editor 50



Pattern Editor

List of Charts Included in Pattern

Pattern Editor
Clicking the Pattern button in the navigation bar
will open the pattern editor. Like the chart editor,
the pattern editor has a large pane on the left for
displaying the pattern and a narrow pane on the
right for settings. The pattern editor only has one
mode, which is the Pattern Preview mode.

Here, you can see a preview of what your final
pattern output will look like. You can also give
your pattern a Title and Subtitle, include a
pattern Summary and set the Copyright footer
text.

A Stitch Glossary containing instructions for all
the stitches used in all your charts is
automatically compiled and appended at the end
of your pattern. You can omit the Glossary by
unchecking Include Stitch Glossary.

Including Charts in the Pattern
All the charts in your design will be listed under Charts Included. You can decide
which of those charts should be included in your pattern by checking or unchecking
them. Each time you add a new chart to your design it is included in your pattern by
default.

If you would like to change the order in which the charts appear in your pattern, you
can reorder the charts in the list by dragging and dropping them into the order you
want. Your pattern will be automatically updated to reflect the chart ordering in the
list.
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Sizing the Image, Setting Top Margin and Placing After Summary

Configure the Photo Size and Placement

Including Photos in the Pattern
Under Photos Included you can click the Add
New Photo button to include photos or other
image files in your pattern. Photos can be PNG,
JPG or BMP files.

After you have selected a photo to include the
Photo Size and Placement window will appear.
This window contains options for configuring the
size and placement of the photo within your
pattern.

The maximum size of the photo is constrained by
the page size. By default, EnvisioKnit will find the
best fit for the photo you provide, scaling it down
to fit the page if necessary. You can reduce the
photo size further by setting a custom Width or
Height. The aspect ratio of the original photo will
be preserved as you change the size, so changing the width or height will correspondingly adjust the height or width. Clicking the
Set to Default button will set the image size to the best fit.

The Top Margin and Bottom Margin settings
are used to set the upper and lower spacing
between your photo and other pattern content.
The preview box will show the image margin in
gray, along with your image in blue, sized relative
to the page. The page margin is shown as a red
line.

The image can be placed at various places in the
pattern. The options for placement are: Before
Title, After Title, After Designer, After
Summary, After Charts, or After Stitch
Glossary. Multiple images can be placed at the
same location, and they will be ordered according
to the Photos Included listing, which can be
sorted. Please note that sorting will only affect
ordering with regards to images at the same
pattern location.

The Horizontal Image Placement options are Centered (default), Left or Right. This determines the justification of the image
horizontally across the page.

Finally, you can set the Place Photo on Separate Page option to put the image on its own page in the pattern.

Each photo added to the pattern will be listed under Photos Included. A thumbnail
along with the name of the photo and its size and placement in the pattern will be
shown. To change the settings of a photo double-click on it in the photos list. To
remove a photo, select it and then click the red circle X that appears in the lower
right corner.
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Pattern Editor Toolbar

List of Photos Included in Pattern

Exporting or Printing the Pattern
The Pattern Editor can export the full pattern as an SVG, PNG, JPG, BMP,
Microsoft Word, or Open Office document, with paging and resolution adjustments
available for the image formats. To export, click the button corresponding to your
desired format in the Pattern Editor Toolbar. You can find detailed information about exporting, printing and the different export
formats in the Printing and Exporting section of this manual.
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The Export Toolbar

Printing and Exporting
When you are finished designing your chart or pattern in EnvisioKnit you may want it in a format you can knit from, edit and tweak,
or distribute to others. EnvisioKnit provides several options for exporting charts and patterns and it is also possible to print a
hardcopy directly from the program.

Export Formats

Both the Pattern Editor and the Chart Preview provide options for exporting. The Pattern Editor will export the full pattern document
with the title, summary, all your charts, stitch glossary and any photos you have added to the pattern. The Chart Preview will export
just the individual chart that is being previewed. Both tools have an identical export tool strip and show a preview of the document
that will be exported. To export the document, simply press the tool strip button for the format you want. The last button in the
export tool strip is for printing the document directly from EnvisioKnit.

The export formats supported by EnvisioKnit are:

ZIP (Compressed Export File Archive)

A Zip export file contains a collection of export documents in multiple formats:

PDF, Word (.docx) and Open Office (.odt) documents.
PNG and SVG image files for both the full document and parts of the charts and legends. The chart and legend parts can be
useful if you are reformatting your pattern in a word processor or other program.
Text content of the chart or pattern.
A snapshot of the EnvisioKnit Design file at the time of the export

SVG (Vector Image)

SVG (Scalable Vector Graphics) is a vector image format. This means that you can zoom in infinitely without the image becoming
jagged or pixelated. SVG supports both editable text and images. SVG is a fairly new format, but is quickly being adopted as an
image standard in image editing software. We recommend using Inkscape (free) or Adobe Illustrator to view and edit this format.

PNG (Raster Image)

PNG (Portable Network Graphics) is a compressed, but lossless pixel-based image format. This means that PNG images can have
a reduced file size without a reduction in quality. Compared to BMP, PNG is a relatively new format, and though it is now standard
in most modern programs, older ones may not support it. PNG images can also support transparency.

BMP (Raster Image)

BMP (Bitmap) is an uncompressed pixel-based (or "raster") image format. It's one of the older image formats, so most older image
processing programs will support it. However, because it is not compressed, the image files can be quite large (in terms of bytes).

JPEG (Raster Image)

JPEG is a compressed and lossy pixel-based image format. This means that JPEG images have a reduced file size, but achieves
this at the cost of reduced quality. JPEG is an older format, and widely supported, but is not optimal for images containing text and
symbols, where PNG can usually produce better results in terms of both quality and file size. For quality reasons, we generally
don't recommend using the JPEG format for charts, but the option is available if it is needed.

DOCX (Word Document)
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DOCX is the Microsoft Word document format. It is supported by Word 2010 and later. This format supports both editable text and
images.

ODT (Open Office Document)

ODT is the Open Office document format, which is an open source word processing application. This format can contain both
editable text and images. EnvisioKnit uses the SVG (vector graphics) format for charts and legends in Open Office. If you plan to
edit the pattern after exporting, we recommend using the Open Office format. Open Office supports exporting your edited document
to PDF.

PDF (Adobe Document)

PDF is a widely used document format and one of the most popular formats for distributing patterns online. EnvisioKnit takes
advantage of the PDF vector graphics capabilities to generate infinitely scalable pattern documents. Several PDF viewers are freely
available, the most popular being Adobe Reader. PDF files can be edited by Adobe Illustrator, and other editors exist as well, but
may have limited capabilities.

PDF Password Protection

EnvisioKnit has the capability to add
password protection to your PDF files.
When you export a chart or pattern as a
PDF, EnvisioKnit will ask if you would
like to password protect it. Additionally,
you can password protect a PDF that
has already been created by clicking
Tools->Password Protect PDF in the
main menu. The PDF file is not required
to have been created with EnvisioKnit.

A PDF can have one or two passwords.
The first password is the "User"
password, which allows access to the
PDF with the security limitations that you
choose. The second password is the
"Owner" password, which allows full
access to the PDF file with all
permissions and no limitations. The
owner password is optional and if you do
not set it then owner access will be
disabled.

The security options for user access are
to allow:

Content extraction which lets users
copy text and images from your PDF and paste them into other documents.

Printing to hard-copy.

Modification or editing in a PDF editor.

As an example, you might choose to give test knitters an owner password so that they can edit and copy and paste content from
your pattern PDF as they provide feedback during testing. At the same time, you could have a different user password for regular
customers who purchase your pattern, with which editing and copying capabilities are disabled.

TXT (Text Document)

55



Print Chart or Pattern

Print from the Main Menu

TXT is a plain text document format. Text documents contain only the text content of the exported patterns or charts (i.e. Title,
author, summary, notes, written instructions and stitch glossary) and do not include images or the charts themselves. If you
choose to do your final editing in a program that does not support any of the other document formats, you can use the text export
option to extract the text of your pattern from EnvisioKnit so that you can paste or import it into the other program.

Printing

The last button in the export toolbar is the Print button. Pressing the print button will allow you to print the document shown in the
preview directly from EnvisioKnit. This is a handy option if you need to make a quick hardcopy of your pattern.

Another way to get a quick printout is to go to File->Print in the main menu. You can
also print by pressing CTRL+P at any time. If you do this with the chart editor open,
EnvisioKnit will ask you if you would like to print just the current chart or the full pattern.
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Edit RGB Values

Stitch Symbol Color

Color Wheel

Yarn Studio

Yarn Studio
The Yarn Studio is a pop-up window that will
appear whenever you double click a yarn or select
it from the Yarn navigation drop-down. It will let
you name your yarn and provides several ways for
selecting the color.

Selecting Colors

The Color Wheel and Shade Slider

The color wheel shows all the color hues and tints. You can select a color
simply by clicking on it. Move towards the center of the wheel to get a lighter tint
of your color. Drag the shade slider down for a darker shade.

Entering a Color Name

If you know what color you want but are having trouble getting it with the color wheel, you can just type the name of the color into
the color name box. For instance, you can enter Alizarin, Amaranth, Cinnabar, Crimson, Scarlet, or just Red. EnvisioKnit has a very
large color vocabulary. The color name box is located directly under the selected color.

Those who have done web design or graphical editing are probably familiar with RGB values, which are
numbers representing the amount of red, green and blue in a color on a scale of 0 to 255. The RGB selector
allows you to specify a precise color by setting these numbers. If the last two sentences didn't make much
sense to you, don't worry, it's just another way to pick a color - you can skip it.

Stitch Symbol Color

The color of the stitch symbol used with a yarn is configurable. By default, the setting is automatic so
that the symbols are either black or white, to best contrast with the lightness or darkness of the yarn
color.

To set a custom symbol color, click the color button next to the Auto checkbox. A color selection
window will appear. Choose the symbol color you want, and click OK. The Auto setting will automatically be unchecked. If you
change your mind, you can check it again and let the software choose the symbol color.
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Color Palette

Selected Color
(Royal Blue)

Compliment of Royal Blue

Split-Compliment

Triad

Tetrad

Pentad

Double Compliment

Matching Colors
If you're designing with a lot of colors, the color palette can be useful for picking them out and putting them
together. Select the palette box and then select a color. The palette box will take and keep the selected color for
use later. You can drag and drop a color into a palette box from the selected color, from the colors in the
selected color scheme, or from other palette boxes.

The matching colors tool will suggest other colors that match your selected color, according to different color
schemes. The available color schemes are compliment, split-compliment, triad, tetrad, pentad, double
compliment, analogous, tints, and shades. You can also drag any of these colors into the palette to save for
later.
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Analagous

Tints

Shades
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Selecting a Stitch Palette

Create New Stitch button

Making new basic stitches

Stitches

Stitch Palettes
EnvisioKnit stitches are organized by type into stitch palettes. The built-in stitch
palettes are Basic Stitches, Increases, Decreases, Cables and Twists, Texture
Stitches, Edge Stitches, Brioche Stitches and Custom Stitches. There are also
two automatically generated palettes: Recent and Used. In addition to these,
designers may create their own "designer" palettes to organize sets of stitches
according to their preferences. The Aran and Lace palettes are designer palettes
that include a variety of stitches specific to those types of knitting charts.

The current stitch palette can be chosen by selecting the name of the palette from the
drop-down list at the top of the stitch selector. The stitches contained in the current
palette are listed below. The current stitch can be selected by clicking on it in the list.
It will be highlighted to indicate that it is selected.

All stitches are fully customizable. The abbreviation, instructions and symbol for any
stitch can be modified. To edit a stitch, double-click on it in the stitch palette. The
Stitch Properties window will appear to allow you to make these changes.

A stitch can be removed from a palette by selecting it and then clicking the 'X' icon
that appear in its bottom-right corner. Any stitch in the list can be reordered by clicking on and dragging it to the desired position.

Built-In Stitch Palettes

The built-in stitch palettes contain a set of the most commonly used stitches by
default. However, you can add additional ones or create your own fully custom
stitches. Each of the built-in palettes has a "Create New..." button at the top of the
palette. Clicking it will open a tool to add stitches to the palette. The tool is different
for each palette and specific to the type of stitch.

Basic Stitches

The basic stitches include knit, purl, no-stitch, slip one, knit through the
back loop, knit one below, and many others. In general, they are single
stitches that do not involve increases or decreases.

The Create Basic Stitch tool has several options. You can create a No-
stitch, a knit stitch, purl stitch, slip stitch, a stitch that is worked through
the back loop, a stitch that is elongated by wrapping the needle additional
times, and many combinations of these.

You may discover particular selections will change your options
appropriately. For example, if you check Slipped Stitch new options will
appear for slipping the stitch purlwise or with the yarn in front.

A stitch symbol, abbreviations and instructions for the stitch are
automatically generated. If you wish, you can customize them later after
clicking OK and adding the stitch to your palette.
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Slipped stitch selected

Increase stitch options

Increases

The increase stitch palette contains yarn over, make one, lifted
increases, knit front and back, various permutations of those and
more. More specific stitch options become available depending on
which general type of increase you select.

Wraps are increases such as yarn-overs in which the working yarn is
wrapped around the needle to create additional loops. Lifted stitches
are increases made by lifting a stitch from the previous row and
working into it. Lifted strand increases involve lifting and working into
the strand running from the last stitch to the next stitch. Many into
one increases are stitches that work several stitches into the next
stitch by alternating the stitch type (front/back, knit/purl, knit/yo/knit,
and so on).
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Decrease stitch options

Cable stitch options

Decreases

Stitches which create one stitch from many are found in the Decreases
palette. The decrease stitch options allow you to set the Stitch Type
(knit or purl), the Lean Direction (right, left or centered) and the
number of stitches worked together.

Cables and Twists

Cables and Twists are stitches involving multiple loops that
cross one another in various ways. This palette is
populated with several of the simpler and more common
stitches of this type.

New cable stitches can be made by selecting the number
of stitches on the Left and Right sides, the direction of the
cross and whether the stitches crossing in back should be
purled. Clicking the More >> button will give the additional
option of specifying middle stitches. The cable symbol
style can be specified, and the options are curved outlines,
straight outlines, and crossing lines.
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Texture stitch options

Edge stitch options

Texture Stitches

Texture stitches are stitches that pop out from the knitted fabric. The
Stitch Types include bobbles, nupps and cluster stitches. Detailed
options specific to each type will appear when you select the stitch
type.

Edge Stitches

Edge stitches deal with the bottoms, tops, or sides of the knit fabric.
They are cast-on, bind-off and wrap and turn stitches.

Brioche Stitches

Brioche stitches are used for brioche knitting charts.
Brioche knitting is a slipped-stitch technique, recently
popularized by Nancy Marchant. Brioche Stitches
include the brioche basics (brk, brp and sl1yo), as well
as brioche increases (brkyobrk, br4st inc, etc...),
decreases (brRsl dec, brLsl dec, br4st dec, etc...), and
cables.
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Brioche stitch options

Brioche increase options
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Brioche decrease options
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Creating custom stitches

Used stitch palette

Custom Stitches

The custom stitch palette contains stitches that you
create, and is empty by default. Custom stitches are
fully configurable. You specify the abbreviation and
instructions, right side and wrong side. You also set
the symbol and the number of cells that the stitch
should occupy on the chart.

The Stitches taken and Stitches made settings are
by default both equal to the number of cells that the
stitch uses. Stitches taken refers to the number of
stitches worked into on the previous row (taken from
the left needle). Stitches made is the number of new
stitches made (put onto the right needle) when the
stitch is worked. If the stitches taken equals the
stitches made, then the stitch is neither a decrease
nor an increase. However, if the stitch takes more
stitches than it makes then it is a decrease. If the
stitch takes less stitches than it makes it is an
increase.

The stitch counts that are optionally included in the
written instructions use these settings to determine
how many stitches will be on the needle when the row
has been worked. The Chart Checker tool also uses
these settings to determine if the number of stitches
taken by one row equals the number of stitches made
on the previous row, and thereby determine if the chart has errors that would make it unknittable.

Automatic Stitch Palettes

EnvisioKnit automatically populates two stitch palettes: Recent and Used. The
Recent palette is initially empty and contains the last 10 stitches you have selected
(by clicking them) in the stitch palette. The Used palette contains all the stitches
used in the current design and it is dynamically updated as you work. Once you have
established your designs, you may find it more convenient to work from these
palettes than to switch back and forth between the built-in palettes to select stitches
of different types. Since they are automatically generated, the Recent and Used
palettes are not editable and are always the last palettes in the palette list.
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Stitch Palette Editor button (pencil)

Adding a new designer palette

Designer Stitch Palettes

You can create designer stitch palettes and add them to the list of built-in and
automatic palettes. Designer stitch palettes can contain any stitch from any of the
other palettes, including custom stitches. They are a convenient way to organize
stitches that are frequently used together in a particular context.

Two designer stitch palettes are added by default: Aran and Lace. Aran contains the
basic knit and purl stitches as well as a selection of cables, and Lace contains the
basic stitches, yarn-over and a set of decreases.

To create a new designer palette, click the button with the
pencil icon to the right of the palette list drop-down. The Stitch
Palette Editor will appear. Click New Palette... and enter a
Palette Name. Click OK and your palette will be added to the
list.

The Stitch Palette Editor also allows the list palettes to be
ordered according to the designer’s preferences. To move a
palette, first select it in the list, then use the arrow buttons to
move it up or down.

Designer palettes may also be renamed or removed from the
palette list. The built-in palettes (Basic Stitches, Decreases,
Increases, etc.) are fixed and may not be renamed or moved,
but may be reordered.
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Stitch Properties

Stitch Properties
The stitch properties window is a pop-up that will appear when you
double click on a stitch in the Stitch Palette. You can edit any
stitch, custom or built-in, except the no-stitch.

The stitch editor allows you to customize the stitch abbreviation
and instructions for both the right-side and wrong-side (the reverse
side). Also, you can change the stitch symbol by clicking the
Change Symbol button, which opens the Symbol Editor.

If you decide that you are not happy with your customizations, you
can always revert the stitch to its out-of-the-box default settings by
clicking the Revert Changes button.

EnvisioKnit also allows you to modify or add a stitch so that it is in
your stitch palette by default by making your changes in the default
stitch palette. Go to the main menu and select Settings->Default
Settings... The Default Settings window will appear. Select the
Stitches tab, and then add your new stitches or make changes to
the existing ones (double-click on a stitch to change it). When you click OK, your default settings will be saved. Then, when you
create a new design, your customizations will appear in the palette. Existing designs will not be affected by your changes to the
default palette, because each design file contains its own stitch palette so that stitches can be customized independently for each
design. See Default Settings for more information about default design options.
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Select the area to place the new shape

Symbols Tab

Symbol Editor

Symbol Editor
With the symbol editor, you can
customize the existing stitch symbol, or
start from scratch and draw your own
using the provided symbol components.
Under the "Shapes" tab, you will find
basic shapes as well as letters and
numbers that you can place and combine
to create custom symbols.

By default, most symbols are set to
stretch to fit the entire stitch cell (or cells,
in the case of cables and other stitches
that use multiple cells) which is usually
not perfectly square (it depends on your
chart's gauge). If you do not want your
symbol to be stretched, you can uncheck
the Stretch symbol to fit cell checkbox.

When editing the symbol, you may require
a finer grid to achive the size and
positioning you want. The Grid Size
setting is set to Normal by default, but
can be changed to Fine or Extra Fine.

The Line Thickness setting for the
symbol lines is set to Normal by default,
but other options include Extra Fine, Fine,
Thick, Extra Thick, 2x Thick and 3x Thick.

The "Symbols" tab contains every stitch symbol already in
your stitch palette, so you can choose an existing symbol to
use as part of your new custom symbol.

Creating New Symbols

To add a new shape to your stitch
symbol, first select the area where the
new shape should go. Click on one corner
of the area inside the Symbol box, and
drag the cursor to the opposite corner.
The region you've selected will be
highlighted in blue.
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Click the shape to add

Now just click the shape you want in the
palette. The open circle was clicked in the
example shown on the right. The new
shape will be positioned and sized to fit
inside the area you have selected.

You can continue to add and combine
shapes this way to build more complex
symbols. If you make a mistake, you can
click the "Remove" button and the last
shape you added will be removed. To
revert back to the original symbol click
"Reset". Click the "Clear" button if you
want to clear the entire symbol.
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Default Pattern Settings

Default Chart Settings

Settings

Default Design Settings
EnvisioKnit allows you to adjust your default design settings so that new designs you create will be automatically customized for
you. You can set defaults for your patterns, charts, yarns, borders, and stitches. When a new design is created, it copies the
settings and palettes currently in the default settings. Changing the default settings does not change existing designs.

Default Pattern Settings

The Pattern Settings include the default designer
name, measurement units (inches or
centimeters), default page settings, pattern text
settings and copyright notice. Please note that if
you prefer to use centimeters rather than inches
in your designs, this is where you should make
that adjustment.

Default Chart Settings

The Chart Settings include the size, in rows and
columns, and gauge for your charts. You can also
set defaults for most of the options in the chart
preview, such as whether the chart is in the
round, the chart numbering style, legend options,
grid color and whether to display the chart title.
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Default Yarn Settings

Default Border Settings

Default Yarn

Customize which yarns you start with. Instead of
the default white yarn, you can start every design
with, for example, a red yarn and a blue yarn, or
whatever color(s) you want.

Default Border

Set your default borders. For instance, you could
always start with a wide green border instead of a
thin blue one.

72



Default Stitch Settings

Default Font Settings

Default Stitches

Setting your default stitch palette is particularly
useful, as this allows you to save the entire stitch
palette, with all your customizations and custom
stitches, just the way you want it.

Default Fonts

Select your default fonts. Choose the style, size
and color of the fonts used in your patterns. The
default fonts are set in the same way as the
Pattern Font Settings

Import and Exporting Settings

The default settings can be exported to and loaded from a settings file. You may find that when doing a particular kind of project,
you prefer particular settings that are different than you would normally use.. Or, you may have installed EnvisioKnit on another
computer and want it to have the same settings. Click the Export Settings button to export the current settings to a file. Click
Import Settings to import them from file. The EnvisioKnit settings files end in the extension “.eks”.

Individual yarns and stitches can be imported into your settings from existing project files. For example, you may have created a
custom stitch for a particular design that you would like to reuse in other projects. Click the Import Yarns or Stitches from
Design button, select the file to import from and select the items you want. Click OK and the items will appear in your default
settings palettes.
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Pattern font settings

Pattern preview shows the new fonts

Font Settings
Clicking "Fonts..." in the Settings menu will bring up the Pattern Fonts window, where you can select the style, size and color of
the fonts used in your pattern.

Selecting Fonts

Select the type of text that you want to customize
from the list on the left side of the window. The
options include the pattern title, regular text, chart
titles and other section headers in your pattern,
the numbers for your chart grid, and the chart
legend headers and regular legend text.

Now select the font you want to use from the
drop-down list under "Font". You can also specify
a font style such as bold or italic from the Font
Style drop-down, and you can click the "Color"
button to select a font color. The preview window
on the bottom will show how your font will look as
you change your selections.

You can also set your desired font size for
Pattern Title, Pattern Text and Pattern
Header/Chart Title. The Grid Number and Legend
text types are sized automatically.

When you are satisfied with your selections, click
OK. Your pattern and chart previews will be
automatically updated to reflect the new settings.
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Pattern Text Settings

Pattern Text Settings
There are several fixed words and annotations
(such as "row", "twice", "sts", etc.) that
EnvisioKnit uses in its automatically generated
written instructions and chart legends. These can
be customized to your preferences in the Pattern
Text settings. To change them, go to Settings-
>Pattern Text in the main menu. Your text
customizations will apply to all charts in your
pattern.

Default pattern text settings can be set on the
Pattern tab of the Default Settings.

Instruction Text

The Pattern Text settings window organizes the
options onto two tabs: Instructions and Legend.
On the Instructions tab you will find:

Row Text

Parentheses Style

The Parentheses Style setting determines the type of parentheses used for repeats in written stitch instructions. The default is the
Square parentheses style, which uses only square brackets: []. The Round setting will similarly use only round parentheses: ().
The Nested setting will use a combination of bracket styles, depending on how many times the sequence of stitches is nested
within another sequence.

With the Nested setting, a repeated sequence of stitches that does not contain another sequence is grouped using round
parentheses: (). Sequences containing these groups use square parentheses: [], and sequences containing 2 levels of nested
sequences use curly braces: {}. For example: {[(K2, p1, k2tog, yo) twice, k2, yo, s2tog-k1-p2sso, yo] twice, k1, p3} 5 times.

Stitch Counts

There are several text options for stitch counts in the instructions:

Sts: Customize the “sts” text that appears after the count number.
Surround With: The parentheses that surround the stitch counts can be modified or omitted. For example, enter [] to use
square brackets instead of round parentheses. Leave the setting blank to show just the number.
Place period after stitch count: can be unchecked to place the period at the end of your instructions, before the stitch count.
Text Style: sets the stitch count text style to Regular, Bold or Italic.

Row Repeats
The Flat and Circular settings determine the text used to indicate repeated rows or rounds in the written instructions. For example,
with a stitch pattern consisting of 20 rows of stockinette, setting the Flat setting to “rep” will result in the final line reading: Rows 3-
20: Rep 1-2.

Stitch Repeats
Twice: If a stitch sequence is repeated twice, the word “twice” is used in the stitch instructions. This setting could, for
example, be changed to a non-english setting like “2x” or “zweimal”.
Times: If a stitch sequence is repeated more than twice, the word “times” is used in the stitch instructions, following the
number of repeats. This could be changed to “x” or “mal”.

Color Instructions
In: If color instructions are enabled, the stitch instructions will give the stitch sequence, followed by the word “in” and then the
yarn name or alias. This can be changed to another word, such as “with” or “mit”.

Row Labels
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Legend Text Settings Tab

Single: The stitch instructions for a single row is preceded by a label with the word “row” followed by the row number. The “row” text
can be replaced with a word of your choice. For circular instructions, the label uses the word “round”, which can also be replaced.
Plural: For a group of rows, the label uses the word “rows” followed by the row numbers. For circular instructions, it uses “rounds”.
Both words can be overridden with a custom setting.

Override Every-other-Row Preamble

Charts using the “Skip every other row” numbering setting will automatically include a line at the beginning of the written instructions
that says “Work all even rows in established pattern” (or odd rows, if that is the case). To override this line, check the Override
Every-other-Row Preamble checkbox and set the text to your preference, or leave it blank to omit the line altogether.

Row Side

It can be helpful to indicate which side of the fabric a row is worked on (i.e. RS or WS). You can enable row sides in the row labels
by checking the box next to the side you want to show. Once enabled, you can also customize the text that will be displayed. The
indicators will be inserted after the row number and before the colon. For example, Row 1 (RS): K20. By default, only the first
instance of each side is labeled, but you can label all of them by unchecking Label first instance only.

Legend Text

The Legend Text tab contains custom settings
for the legend headers and the stitch legend:

Headers

Each section of the legend can include a title, or
header, which can be customized. The default
headers are Yarn, Stitches and Borders.

Stitch Legend

A charted stitch that is worked from both the right
and wrong sides of the fabric will include the
abbreviation for both sides. For example, with the
default settings, a charted knit stitch will be listed
in the legend as follows: RS: k; WS: p. The RS,
WS and separating semicolon can all be
customized here.
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Page Settings

ISO A4 Page Size

Page Settings
EnvisioKnit lays out patterns and charts according to its Page Settings. By default, the page
settings are set to 8.5x11" (portrait) pages. To change the page settings, go to Settings->Page
Settings... in the main menu. A window will appear where you can set the page size and
orientation.

The orientation can be set to either Portrait or Landscape and the size options are Letter (8.5 x
11"), Legal (8.5 x 14"), Ledger (8.5 x 17") or International ISO. If International ISO is
selected, additional options will appear to select the ISO 216 Series and Size. Supported ISO
216 page sizes are A3, A4, A5, B3, B4 and B5.

Default page settings can be set on the Pattern tab of the Default Settings.
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First select your design file

The Import tool is in the "Tools" menu

Tools

Importing Charts, Yarns and Stitches

The Import Tool

EnvisioKnit has an Import tool that allows you to bring charts, yarn, and stitches
created in other design files into your current design. This allows you to use your
existing design files as libraries to build on for future designs.

You can find the Import tool under "Tools" in the main menu.

Select the Design File

To use the import tool, first select the design file you want to import from.
Once you've opened a design, it will stay listed in the "Design File" drop
down for easier access in the future.
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Select a yarn to import

Select a chart to import

Select and Import a Chart

Now that you've loaded a design file, you can choose which of its charts,
yarns, or stitches you would like to import. The charts, yarns and stitches
contained in the design file are listed in the tabs below. To import a chart,
select a chart from the "Charts" tab and click OK.

Importing a Yarn

To import a yarn, select the yarn you want from the "Yarns" tab and click
OK. The selected yarn will be added to your current design's yarn palette.
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Choose to import or replace the chart's original yarns

Select a stitch to import

Importing a Stitch

To import a stitch, select the stitch you want from the "Stitches" tab and click
OK. The selected stitch will be added to your current stitch palette. If the stitch
is already in your palette, you will be given the option to replace the existing
stitch with the stitch you are importing.

Importing a Chart

When you import a chart, EnvisioKnit will let you
decide how to import the yarns that it uses.

After selecting the imported chart, the "Import Chart"
window (shown on the right) will appear. At the top of
this window, you will see a list of all the yarns used in
the chart. The original yarn from the chart is shown on
the left side, and the yarn it will import as is shown on
the right. The button in the middle lets you select
whether you want to import or replace the original yarn
with one from your design. At the bottom of the
window, you will find a preview of the chart as it will
appear when it is imported.

By default, each yarn will be imported, resulting in the
chart remaining in its original color scheme. Each yarn
will be added to your current design's yarn palette.
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You can replace the chart's original yarns with yarns from your palette

The chart is imported using the yarns you selected

Replacing Yarns

If you use the "Replace With" option, the yarn on the
right will be replaced with a drop down in which you
can select a yarn from your current palette. The
preview window at the bottom will be updated to reflect
your selection.

The Imported Chart

Once you have finished with the Import Chart window,
click OK, and the chart will be imported into your
current design using the yarns you selected.
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Selecting Colors to Use from the Image

Viewing the Image in the Chosen Colors

Creating Picture Charts
EnvisioKnit's Picture Chart tool creates knitting charts from photos or other images. This tool offers fantastic creative possibilities,
allowing you to quickly create striking graphical charts. To open the Picture Chart tool, go to Tools->Create Picture Chart.

Choosing an Image

When you first start the Picture Chart tool, you will need to select an image file to use. You can use .png, .jpg or .bmp image files. For
graphical charts, images with good color contrast work best. You will be able to position and size the chart to use all or just a part of the
image.

Selecting Colors

With your image loaded, you must now choose the
set of colors that you want in the chart. Most images
are composed of thousands of colors, but to make a
practical knitting chart you will want to use only a
handful of yarns. You may choose as many yarns as
you want to use, but you must choose at least two.
The image will be simplified to use only the yarn
colors you have chosen.

One way to choose a color is to click on the image
over the color you want. A selection ring will appear on
the image where you clicked and the color at that
location will be added to your yarn palette. You can
adjust the color you have just added by dragging the
selection ring around the image. The associated yarn
color will be updated to the color of the image under
the selection.

To remove a selection, click on it and then press the
Delete key. You can also remove the yarn in the list
by selecting it and clicking the red X that appears in
the lower right corner.

Another way to add yarns to the list is to click Add
New Yarn. Doing so will allow you to choose colors
that are not in the image. Yarns that are already in
your current design can be added by clicking Add
Yarn from Design. If you choose yarns from your
design you can import the image using the color
scheme you have already established.

To see how your image looks in just the colors you
have chosen, check the "View Image in Chosen
Colors" option, under the yarn list. In the reduced image, each color will be replaced with the closest color that you have chosen.

Click Continue to proceed to the next step.

Sizing and Positioning the Chart

You will now have a chart overlaid on your image.
Initially, the chart size, gauge and grid color will be set
according to the default. The gauge, or aspect ratio of
the grid cells, as well as the grid size and color, can
be adjusted using the controls in the panel on the
right.
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Chart Overlay Before Sizing and Positioning

Chart Overlay After Sizing and Positioning

Finished Picture Chart

Click and drag a corner of the grid to expand or
contract the size of the chart relative to the image.

Click and drag the sides of the grid to increase or
reduce the number of rows and columns.

Click and drag on the middle of the grid to reposition it
over the image.

When you are satisfied with the grid representation of
your image, click the Finish button to add it as a new
chart in your design.

83



Create a Chart from Written Instructions

Example Shown:

Row 1: [k2, p2] 5 times, k1.
Row 2: [p2, k2] 5 times, p1.
Rows 3-20: Repeat rows 1-2.
            

Creating Charts from Written Stitch Instructions
EnvisioKnit has a special tool for generating charts
from knitting stitch instructions. This tool is very useful
if you have an existing pattern in written form that you
would like to bring into EnvisioKnit as a chart. You can
find the Chart from Written Instructions tool under
Tools->Create Chart from Written Instructions... in
the main menu.

When you open the tool, you will initially see a blank
preview area at the top and a text editing area below.
There is a status area at the bottom left of the window,
and a settings area at the bottom right. The preview
will automatically update as you enter stitch
instructions in the text area.

The stitch text you enter is "parsed", or interpreted by
the program. If there are no errors, a draft chart is
constructed and shown in the preview. The parser will
wait for you to stop typing momentarily before re-
parsing and updating the chart. If the parser finds
errors in your instructions, the status area will turn red
and list the errors. To force an update, click the
Refresh button in the lower left corner.

Stitch Syntax Rules

In order for EnvisioKnit to understand your stitch pattern, the format of the written instructions must conform to certain rules. If the
program cannot parse or understand the entered text, it will indicate this with a message in the status area, and will also underline the
problematic text in the text editor. The whole pattern must be understood and error free before a chart can be generated.

Stitches must exist in the Stitch Palette.
The stitch abbreviation will be used to match a written stitch to a charted stitch. Matching is not case sensitive.
The stitch must exist in the stitch palette for the current design.
If you need to add a stitch to the palette, click the Stitches..." button and add it there.

Stitches must be separated by commas.
Semi-colons are treated as commas.
Whitespace before and after the stitch name is ignored.

Each row instruction must be on a separate line.
Periods are optional at the end of lines. Periods within the line will be treated as commas.

Repeats of a single stitch must be written directly after the repeating stitch, i.e. "k2tog 3 times" or "k2tog 3x".
Knit and purl stitches are special and can be written with the repeat number appended to the stitch abbreviation, i.e. "k20" or
"p20".
Repeats of 2 can be written "twice", i.e. "k2tog twice".

Repeats of multiple stitches must be enclosed in square brackets and followed by the number of repeats, i.e. "[k2, p2] 10 times".
Like single stitches, the repeats must be of the format "5 times" or "5x" and "twice" can be used instead of "2 times".
Repeats of single or multiple stitches can be nested within larger repeats of multiple stitches.

Row instructions can be labeled with a row or round number, i.e. "Row 1: k20."
If the first row does not have a row number, it will be numbered row 1. Subsequent unnumbered rows will be numbered
sequentially.

84



Chart Creation Settings

Set the Chart's Name, Gauge, and Default Yarn

Example 1:

k10, k5, k1, k4.
p20
k4 5 times
[p4,p2,   p4] twice.
k10 2x.

The same number cannot be assigned to multiple rows.
For circular instructions, use the label "Round" instead of "Row", i.e. "Round 1: k20."

If any row is labeled "Round", then the full pattern will be interpreted as a circular pattern. Otherwise, flat knitting is assumed.
You can indicate that the first row is a wrong-side row by adding "(WS)" to the row label, i.e. "Row 1 (WS): p20."

If the first row is not labeled with "(WS)", it will be a right-side row.
Only the first row may be labeled with "(WS)". If subsequent rows use the label it will be ignored.

A row instruction can define multiple rows, which have identical instructions. For example: "Rows 1-10: K20."
For circular knitting, use "Rounds" instead of "Rows", i.e. Rounds 1-10: K20.
A set of non-sequential rows can be labeled with commas between row numbers, i.e. "Rows 1, 5, 9: P20."

A row instruction can refer to a previous row. For example: "Row 3: Repeat row 1."
A row instruction can also refer to a range of previous rows. For example: "Rows 11-20: Repeat rows 1-10."

Charts will begin with the first defined row and end with last one.
Undefined rows within this range will be charted as determined by the Undefined Rows setting.
The default setting for Undefined Rows is stockinette.

Settings

The settings for the Chart from Written Instructions tool are located
at the bottom right of the window.

The Chart Settings button opens a window where Name, Gauge and
Default Yarn of the chart can be set.

The Stitches... button opens the current stitch palette so that you can
add or modify stitches if necessary.

If you would like to create a chart in which only
alternate rows are charted (i.e. for cables or lace
where alternate rows are plain) then check the Chart
Every Other Row box.

Your written instructions may not define every row
within the chart. Undefined rows will be charted as
determined by the Undefined Rows setting. The
options are Stockinette, Blank, Skipped and
Renumbered, Knit Across, and Purled Across.
Stockinette will set undefined rows to stockinette
stitch, so right side rows will be knit and wrong side
rows will be purled. Blank will set undefined rows to
the invisible (background) no-stitch. Skipped and
Renumbered will skip undefined rows, renumbering
subsequent rows to follow previous rows sequentially. Knit Across will set undefined rows so that they are worked as knit rows, whether
they are right-side or wrong-side. Purl Across will set undefined rows so that they are worked as purl rows, whether right-side or wrong-
side.

Examples

The following four examples all produce 10 rows of 20 stitches of stockinette:

Example 1

In example 1, row numbers are not specified, so the first row is assumed to
be 1 and the following rows are numbered sequentially from there. The first
line shows that stitches may be separated by commas. Whitespace between
stitches is optional and effectively ignored by the parser. Periods at the end of
lines are optional. The third line in example 1 illustrates that stitches may be
repeated by specifying "5 times" after the stitch, where 5 can be replaced by
any number of repeats. The fourth line shows that several stitches, "p4,p2,
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p20
[[k1, k1] 2 times] 5 times
p20
k20
p20
    

Example 2:

Rounds 1-10: k20.
    

Example 3:

Row 1: k20.
Row 2: p20.
Row 3-10: Repeat rows 1-2.
    

Example 4:

Row 4 (WS): p20.
Row 5: k20.
Rows 6-13: Repeat rows 4-5.
    

p4" can be repeated as a set using square brackets [], and that "twice" can
be optionally used instead of "2 times". The fifth line demonstrates that the
syntax "2x" can be alternatively used to "2 times". The seventh line shows
that repeated sets can be nested within larger repeated sets. Any stitch
abbreviation defined in your current stitch palette may be used. Only knit and
purl stitches may use the syntax k20 or p20, where 20 is the number of times
to work the knit or purl. Instead, repeats of other single stitches should be
indicated using the "twice", "2x" or "2 times" syntax, for example "yo twice".

Row numbers are optional. Example 1 does not use any row numbers, but the other examples do. Lines may optionally be prefixed like
so: "Row 1:" or "Round 5:", where the number must be included. If at least one line is prefixed with "Round", then the instructions will be
interpreted as being knit in the round, otherwise they will be interpreted as flat knitting. The first row is assumed to be a right-side row. If
rows are written without prefixes, they are numbered sequentially from the previous rows. An unnumbered first row is assumed to be
Row 1.

Example 2

In example 2, the prefix "Rounds" is used to indicate that the instructions
should be interpreted in the round. Examples 2 and 3 show that one line may
specify the instructions for a a set of rows. The syntax for this is "Rows 1-
10:", where 1-10 may be any range of rows that have not yet been defined,
and "Rows" may be replaced with "Rounds" if the chart is worked in the
round.

Example 3

In example 3, the third line specifies a range of rows, 3-10, that should repeat
a set of previous rows, 1-2. Example 3 defines a range of 8 rows that repeats
a previous set of 2 rows. The syntax for this is "Repeat rows 1-2", where 1-2
may be replaced with any range of rows that have been previously defined in
the instructions. If the chart is in the round, then "rows" may be replaced with
"rounds".

Example 4

In example 4, the first line is marked as Row 4, so the first row of the chart
will be labeled "4". It is also marked as a wrong-side row, using the "(WS)"
tag before the colon. Only the first row of the chart should be marked right-
side or wrong-side via the tags (RS) or (WS). Use of these tags on any other
row will be ignored.
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The Bug Report Form

Other Features

Updates
EnvisioKnit Design Studio has a built-in updater. When the program starts it checks the website for a newer version. If there is one, the
updater will inform you of it and ask if you'd like to do the update now. You can also check for updates using the Check for Updates
button in the Help menu.

Autosave, Crash Recovery and Bug Reports
We do everything we can to prevent situations in which the program will
crash. However, to reduce the potential for loss of work, EnvisioKnit
autosaves your design once every minute, and retains the last five
minutes of autosaved files. If a crash occurs, EnvisioKnit will attempt to
load one of the autosave files when it restarts, starting with the most
recent. Also, if the program crashes, we provide a form for you to
automatically submit information about what the program was doing
when it crashed (a bug report). Submitting this form automatically
sends us the internal details of the crash, and helps us provide a fix for
the issue as quickly as possible.
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